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2 PROJECT TEST PLAN HANDHOOK IDENTIFICASTION DETAILS 

 

2.1 COVER PAGE 

Document has to be identified in the cover page with the following labels 

<PROJECT NAME> 

TEST PLAN 

Version <1.0> 

<DD/MM/YYYY> 

 

2.2 TEST PLAN VERSION HISTORY 

Document and test plan version history have to be identified with the following table: 

 

VERSION HISTORY 

[Provide information on how the development and distribution of the Test Plan, up to 

the final point of approval, was controlled and tracked.  Use the table below to 

provide the version number, the author implementing the version, the date of the 

version, the name of the person approving the version, the date that particular 

version was approved, and a brief description of the reason for creating the revised 

version.] 

Version 

# 

Implemented 

By 

Revision 

Date 

Approved 

By 

Approval 

Date 

Reason 

1.0 <Author name> <dd/mm/yy> <name> <dd/mm/yy> Test Plan draft 

      

      

Template Version: 15/11/2015 

 

2.3 TEST PLAN DOCUMENT HEADER & FOOTER  

Each document page has to be identified with the following table in the page 

header and page footer: 

 

Header 

 

 CubeIQ Limited  

 Test Plan Handbook Page 6 of 22 

   

 Confidential  Gen. Release: 2.00.10 
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  Date: 15/11/2015 

     

 
 <Project Name> 

 

Footer  

Doc Ref: CIQ_TestPlanHandbook.V1.2.2010.EN.docx 

© 2005 - 2016 CubeIQ Ltd. Proprietary & Confidential information. Reproduction prohibited 

Third party product names are used to identify such products and are for descriptive purposes only. Such 

names may be marks and/or registered marks of their respective owners. 

 

2.4 NOTE TO THE AUTHOR   

Note to the Author 

[This document is a template of a Test Plan document for a project. The template 

includes instructions to the author, boilerplate text, and fields that should be replaced 

with the values specific to the project. 

 

 Blue italicized text enclosed in square brackets ([text]) provides instructions to the 

document author, or describes the intent, assumptions and context for content 

included in this document. 

 

 Blue italicized text enclosed in angle brackets (<text>) indicates a field that should 

be replaced with information specific to a particular project. 

 

 Text and tables in black are provided as boilerplate examples of wording and 

formats that may be used or modified as appropriate to a specific project.  These 

are offered only as suggestions to assist in developing project documents; they 

are not mandatory formats. 

 

When using this template for your project document, it is recommended that you 

follow these steps: 

 

1. Replace all text enclosed in angle brackets (i.e., <Project Name>) with the 

correct field values. These angle brackets appear in both the body of the 

document and in headers and footers.  To customize fields in Microsoft Word 

(which display a gray background when selected): 

a. Select File>Properties>Summary and fill in the Title field with the 

Document Name and the Subject field with the Project Name.   

b. Select File>Properties>Custom and fill in the Last Modified, Status, and 

Version fields with the appropriate information for this document.  

c. After you click OK to close the dialog box, update the fields 

throughout the document with these values by selecting Edit>Select 

All (or Ctrl-A) and pressing F9.  Or you can update an individual field 

by clicking on it and pressing F9. This must be done separately for 

Headers and Footers. 

2. Modify boilerplate text as appropriate to the specific project.  
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3. To add any new sections to the document, ensure that the appropriate 

header and body text styles are maintained.  Styles used for the Section 

Headings are Heading 1, Heading 2 and Heading 3.  Style used for boilerplate 

text is Body Text. 

4. To update the Table of Contents, right-click and select “Update field” and 

choose the option- “Update entire table” 

5. Before submission of the first draft of this document, delete this “Notes to the 

Author” page and all instructions to the author, which appear throughout the 

document as blue italicized text enclosed in square brackets.] 
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3 INTRODUCTION 

3.1 PURPOSE OF THE TEST PLAN DOCUMENT 

[Provide the purpose of the Test Plan Document. This document should be tailored to 

fit a particular project’s needs.] 

The Test Plan document documents and tracks the necessary information required to 

effectively define the approach to be used in the testing of the project’s product. The 

Test Plan document is created during the Planning Phase of the project. Its intended 

audience is the project manager, project team, and testing team. Some portions of 

this document may on occasion be shared with the client/user and other stakeholder 

whose input/approval into the testing process is needed. 
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4 COMPATIBILITY TESTING 

4.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

4.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

4.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

4.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

4.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

4.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

4.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

4.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

4.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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5 CONFORMANCE TESTING 

5.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

5.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

5.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

5.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

5.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

5.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

5.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

5.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

5.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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6 FUNCTIONAL TESTING 

6.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

6.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

6.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

6.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

6.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

6.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

6.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

6.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

6.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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7 LOAD TESTING 

7.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

7.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

7.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

7.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

7.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

7.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

7.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

7.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

7.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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8 PERFORMANCE TESTING 

8.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

8.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

8.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

8.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

8.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

8.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

8.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

8.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

8.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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9 REGRESSION TESTING 

9.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

9.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

9.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

9.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

9.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

9.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

9.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

9.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

9.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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10 STRESS TESTING 

10.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

10.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

10.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

10.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

10.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

10.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

10.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

10.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

10.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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11 SYSTEM TESTING 

11.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

11.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

11.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

11.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

11.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

11.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

11.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

11.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

11.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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12 UNIT TESTING 

12.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

12.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

12.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

12.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

12.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

12.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

12.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

12.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

12.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 
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13 USER ACCEPTANCE TESTING 

13.1 TEST RISKS / ISSUES 

 [Describe the risks associated with product testing or provide a reference to a 

document location where it is stored. Also outline appropriate mitigation strategies 

and contingency plans.] 

13.2 ITEMS TO BE TESTED / NOT TESTED 

[Describe the items/features/functions to be tested that are within the scope of this 

test plan. Include a description of how they will be tested, when, by whom, and to 

what quality standards. Also include a description of those items agreed not to be 

tested.] 

Item to Test Test Description Test Date Responsibility 

    

    

    

13.3 TEST APPROACH(S) 

[Describe the overall testing approach to be used to test the project’s product. 

Provide an outline of any planned tests.] 

13.4 TEST REGULATORY / MANDATE CRITERIA 

[Describe any regulations or mandates that the system must be tested against.] 

13.5 TEST PASS / FAIL CRITERIA 

[Describe the criteria used to determine if a test item has passed or failed its test.] 

13.6 TEST ENTRY / EXIT CRITERIA 

[Describe the entry and exit criteria used to start testing and determine when to stop 

testing.] 

13.7 TEST DELIVERABLES 

[Describe the deliverables that will result from the testing process (documents, reports, 

charts, etc.).] 

13.8 TEST SUSPENSION / RESUMPTION CRITERIA 

[Describe the suspension criteria that may be used to suspend all or portions of 

testing. Also describe the resumption criteria that may be used to resume testing.] 

13.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS 

[Describe any specific requirements needed for the testing to be performed 

(hardware/software, staffing, skills training, etc).)] 



CubeIQ Software Test Plan Handbook 

© 2016 CubeIQ Limited and its Affiliates  Page 20 of 22 

14 TEST PLAN APPROVAL 

The undersigned acknowledge they have reviewed the <Project Name> Test Plan 

document and agree with the approach it presents. Any changes to this 

Requirements Definition will be coordinated with and approved by the undersigned 

or their designated representatives. 

[List the individuals whose signatures are required.  Examples of such individuals are 

Business Steward, Technical Steward, and Project Manager. Add additional signature 

lines as necessary.] 

 

Signature:  Date:  

Print Name:    

Title:    

Role:    

 

Signature:  Date:  

Print Name:    

Title:    

Role:    

 

Signature:  Date:  

Print Name:    

Title:    

Role:    
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14 APPENDIX A: REFERENCES 

[Insert the name, version number, description, and physical location of any 

documents referenced in this document.  Add rows to the table as necessary.]  

The following table summarizes the documents referenced in this document. 

Document Name 

and Version 

Description Location 

<Document Name 

and Version 

Number> 

[Provide description of the 

document] 

<URL or Network path where 

document is located> 

 



CubeIQ Software Test Plan Handbook 

© 2016 CubeIQ Limited and its Affiliates  Page 22 of 22 

15 APPENDIX B: KEY TERMS 

[Insert terms and definitions used in this document.  Add rows to the table as 

necessary. Follow the link below to for definitions of project management terms and 

acronyms used in this and other documents. 

http://www2.cdc.gov/cdcup/library/other/help.htm 

The following table provides definitions for terms relevant to this document. 

Term Definition 

[Insert Term] [Provide definition of the term used in this document.] 

[Insert Term] [Provide definition of the term used in this document.] 

[Insert Term] [Provide definition of the term used in this document.] 

 

**** EOF **** 


